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Introduction

Introduction

What is Grasshopper?

Grasshopper (GH) is a node-based algorithm editor integrated with Rhino modeling tools.
Algorithms are used to describe logical relationships among design parameters that define the
parametric model. Through algorithms, the user is able to establish a set of rules that define the
sequence of operations, thus aiding the design process.

What is the purpose of the Grasshopper-ARCHICAD Live Connection
tool?

The Grasshopper-ARCHICAD Live Connection offers a unique design workflow, using algorithms,
which helps you explore a large number of design variations and create and fine-tune building
details and structures - without exchanging files.

Key features and benefits

¢ Translate simple geometry created in Rhino into BIM construction elements
e Bi-directional connection — no need to export/import file for data exchange
¢ Dynamic (live) connection while editing

¢ Direct and simultaneous graphical feedback from both Rhino and ARCHICAD

Supported workflows

This set of tools enables Rhino/Grasshopper (GH) and ARCHICAD (AC) to communicate directly.
Designers working in either Rhino/Grasshopper or ARCHICAD can utilize its functionality to their
advantage. Users can start the design process in either work environment (AC or RH or GH). In
each case, the user will select an original set of reference geometries to be manipulated via
Grasshopper, or create it from scratch in Grasshopper.

e  “Start with pure 3D geometry” workflow: Designers start with the design geometry using
Rhino and Grasshopper. With the “GH-AC Connection” tool, they can dynamically generate a
BIM model consisting of ARCHICAD construction elements, and update the resulting BIM
model directly from Grasshopper.

e “Start with intelligent building elements” workflow: Designers start with the design in
ARCHICAD and extend their AC toolbox with algorithmic design methods applied to AC
elements. In this workflow, input reference geometries (reference points, curves and other
parameters) are taken directly from ARCHICAD and used in Grasshopper, without interaction
in Rhino.
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Introduction

Scope of the manual

This manual is intended to explain only the added functionality of creating ARCHICAD elements
from Grasshopper. The general description of functionality of ARCHICAD, Grasshopper or Rhino
is not in the scope of this manual. To acquire the necessary basic knowledge in these
applications, please visit the following sites.

e Grasshopper Training Center: http.://www.grasshopper3d.com/page/tutorials-1

e ARCHICAD Training Materials:_http://www.graphisoft.com/learning/training_materials/

e Rhinoceros3D Learning Center:_http://www.rhino3d.com/learn
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Release Notes for Version 1.7

Release Notes for Version 1.7

Added features

New preview option

By activating the new option, a more precise preview of ARCHICAD elements is displayed in
Rhino, which also includes colors.

New Zone Component

The Grasshopper code can now generate ARCHICAD Zone elements as well. Zones can be defined
by Curve type data. Their parameters can be controlled by the new Zone Category Input Node
and Zone Settings Node.

New Door and Window Components — point based positioning

The position of the opening element along the host Wall’s reference line is defined by a Point
input parameter.

Improvements

“Bake” generated elements in ARCHICAD

It is now possible to copy-paste Grasshopper-generated elements to keep and compare different
design variations. These duplicates will no longer be associated with or affected by the
Grasshopper code. (Previously it was not recommended to use copy-paste to replicate generated
elements in ARCHICAD, because the next time the GH code was executed, the elements created
by copy-paste were deleted.)

Separate Morph Components for Mesh and Curve

For a cleaner workflow, Morph Component has been split into two separate components for
converting Mesh type data and Curve type data into ARCHICAD Morph elements.

Fixed bugs

Fixed error messages

Users of Human Ul add-on used to receive error messages when using Grasshopper-ARCHICAD
Connection.

Stable install process for MAC

In some cases, problems occurred when installing the Connection add-on with the latest Rhino
for MAC WIP version.
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Release Notes for Version 1.7

Parameters of Library Parts no longer available

Controlling several Library Part parameters at once via Grasshopper could result in inconsistent
Library objects generated by the Grasshopper code. For this reason, parameters of standard
default Library Parts are no longer available for manipulation by Grasshopper unless the
necessary changes are made in the Library Part’s GDL code.

For more information, see the Accessing GDL Parameters of ARCHICAD Library Parts.

Feedback on suspended communication

The add-on did not send any feedback about suspended communication (while ARCHICAD is
communicating with users through a dialog, it does not receive information from Grasshopper)
which could be confusing in some cases. Now both the ARCHICAD and Grasshopper User
Interface provide feedback about suspended communication.

Several other minor bugs have been eliminated.
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Getting Started

Install Add-Ons (Windows)
To achieve a connection between the ARCHICAD and Grasshopper applications, you must install
a GRAPHISOFT extension: the Grasshopper — ARCHICAD Live Connection.

Important: ARCHICAD-Grasshopper Connection for Windows is available for AC 18, 19 and 20. You
should install the installer (MSI file) which corresponds to your version of ARCHICAD.

Before installing it, make sure that the latest version of Rhinoceros for Windows (Version 5 64-
bit) and ARCHICAD (version 18, 19, or 20) are both installed on your computer.
To launch the Setup Wizard of the Connection add-on, double-click on its .MSI file and go
through the steps as shown on the setup screens.

Note: ARCHICAD-Grasshopper Connection only works with the 64-bit version of Rhino 5.

#  Grasshopper-ARCHICAD Live Connection Setup - OMEM %  Grasshopper-ARCHICAD Live Connection Setup - OEEM ¥  Grasshopper-ARCHICAD Live Connection Setup - OHEM ¥  Grasshopper-ARCHICAD Live Connection Setup - THEN

S _ Qi —— Destination Folder
Welcome to the Grasshopper-ARCHICAD Pesse read the foowing icense aresment arefly Cick ext o stal o the defaut foderor cck hange to.
Live Connection Setup Wizard

Ready to install Grasshopper-ARCHICAD Live Con:

IMPORTANT o e s ARCHICAD e Comecien Gick sl tobegin thenstalaton, ik Back ta revie o change any o your
PLEASE READ THIS AGREEMENT CAREFULLY. BY CLICKING THE (TR S G = i

"I ACCEPT" BUTTON, YOU INDICATE YOUR ACCEPTANCE OF [CPragram Fles GRAPHISOFTARGAICAD 20
ITHE GRAPHISOFT LICENSE AGREEMENT ("Agreemen )

INCLUDING THE LIMITED WARRANTY AND DISCLAIMERS FOR ey

IYOURSELF, YOUR EMPLOYER AND ANY AUTHORIZED USERS

WHETHER OR NOT EACH SUCH AUTHORIZED USER INDICATES

ITHEIR INDIVIDUAL ACCEPTANCE.

I YOL DO NOT ACCFPT THE TFRMS OF THIS AGRFFMENT

Install Add-Ons (Mac)

To achieve a connection between the ARCHICAD and Grasshopper applications, you must install
a GRAPHISOFT extension: the Grasshopper — ARCHICAD Live Connection.

Before installing it, make sure that the latest version of Rhinoceros for MAC (Version 5 64-bit)
and ARCHICAD (version 20) are both installed on your computer.
Important: Rhino for Mac is currently at a “Work in Progress” stage of development. It does not yet
contain all of the features available in Rhino for Windows. For details, see: https.//www.rhino3d.com/
mac-feature-compare.
To launch the Setup Wizard of the Connection add-on, double-click on its .PKG file and go
through the steps as shown on the setup screens.

Note: ARCHICAD-Grasshopper Connection only works with the 64-bit version of Rhino 5.

The installation was successful.
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Getting Started

Launch the Applications
1. Launch ARCHICAD.
2. Launch Rhinoceros 3D (Rhino).

3. From Rhino, launch Grasshopper:

¢ In Rhino (Windows version): type the word “Grasshopper” into the Rhino Command Line and

hit ENTER.
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Getting Started

¢ In Rhino (Mac version): type the word “ExplicitHistory”

ENTER.

@ RhinoWIP File Edit View Curve Surface Solid Mesh Dimension Transform Tools Analyze Render Window Help

into the Rhino Command Line and hit

@ 33 ©® 0 4 < Shngaan Tue16:44 Barothy,Laura Q=

Grasshopper - No document..
Pararms | Maths Sets Vector Curve Surface Mesh Intersect Transforr

Display ARCHICAD

AW D> @46

00 CELE 00D V0o Y HeEE =i

9300, Groun Fisort

DR @ 3w > o

0000 > m

Untitled - ooe® B) Untitled
O ETETS @I Planar  EEITATTE  Gumball  History (Y oke)] @j}r@;if;i‘@;#' OO0 -BEx R 10 £ 958 HL2E0
FF [] | Perspective | Top | Front | Right Layouts... | Mamn:

3o an ) [South Elevation] R

1100 > £F 020rafting > BB Entire Model > ) 03 Architect..>
= Command: Meters X:-6.75 Y:65.85 Z:0.00 Click an Element or Draw a Selection Area. Press and Hold Ctri+Shift to Toggle Element/Sub-Element Selection. =]
Notes:
e Once all three applications are running, it is recommended to arrange the windows so that they do
not overlap. (For ease of use, use multiple screens).
L]

ARCHICAD (Window > Palettes > Status bar).

To receive notifications and information from the add-ons, turn on the Status bar palette in

It is recommended to set the same Units in both Rhino and ARCHICAD. To set units:

¢ In Rhino: File > Properties > Model Units

¢ In ARCHICAD: Options > Project Preferences > Dimensions

Start the Connection

e In ARCHICAD, go to Design > Design Extras > Grasshopper Connection.
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Getting Started

A small floating palette appears with the “Start Connection” button on it. Click to start the
connection.

View | Design | Document Options  Teamwork Window Help

':?_'\T & Design Tools L4 Q] - - éz._t'{ OF X ‘ :,?@ A
% Story Settings... Ctrl+7
Edit Elements by Stories...

I Connect L4
g? Solid Element Operations...

j’ Outline Polygon with Magic Wand

;‘é Magic Wand Settings...

Medify Merph 4
Medify Curtain Wall 4
Roof Extras 4
| Design Extras TrussMaker 4

i‘é Grid System ...

::: Grasshopper Connection...

i@] Energy Evaluation 4

Grasshopper Palette in ARCHICAD

To open the Grasshopper palette in ARCHICAD, go to Design > Design Extras > Grasshopper
Connection.

Note: Like any other palette in ARCHICAD, the Grasshopper palette is also available from Window >
Palettes.

The palette contains 3 buttons: Grasshopper

Start/Break Connection: Click to turn on/turn off the connection Connected to: unnamed
between Grasshopper and ARCHICAD.
Send Changes: Updates Grasshopper about changes made in
ARCHICAD. This button is active only when you are editing an ARCHICAD
element referred to by the Grasshopper code via a Parameter Node (see Select in GH
the Parameter Nodes section below).
Select in GH: In Grasshopper, selects the nodes which generated the
elements currently selected in ARCHICAD. This button is active only if the current ARCHICAD
selection includes at least one element generated by the Grasshopper code.

Notes:

Break Connection

e [f the green icon is spinning, this indicates that the connection with Grasshopper is live, and
ARCHICAD is now ready to send and receive information.

e The palette also tells you which currently opened Grasshopper document is connected to
ARCHICAD.
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Getting Started

ARCHICAD Tab in Grasshopper

In Grasshopper, a new “ARCHICAD” tab has appeared on Grasshopper's tab bar. The icons on this
tab resemble those of ARCHICAD tools; they represent components, parameters and input
nodes.

Grasshopper - unnamed > B

Fle Edt View Display Solution Help unnamed

Params Maths Sets ‘Vector Curve Surface Mesh Intersect Transform Display | ARCHICAD

SEEs b ouoic v CEIERIE 0 8(s S F TR E AT A7
DU ®eB|a o T EBECCT @0

‘E}E 125% v g - @ - .4 @@ RO Q-

Command in Grasshopper’s File menu

In Grasshopper, a new command appears in the File menu: “Connect Document to ARCHICAD”.
This command opens a dialog box: among the currently open Grasshopper files, choose the one
that should communicate with ARCHICAD.

Grasshopper - Definition_1 = =
File | Edit View Display Solution Help Defintion_1
[[] Mew Document CursN is [ ARCHICAD | v
[ open Document Crd+0 e t‘f“ ﬁf“ =
Recert Files L e
Connect Document to ARCHICAD - B
& save Document Cir+§
il —— TG @ @ |§| @ O O . Select the Grasshopper Document that should communicate with ARCHICAD, 0
Save Backup Ctl+Al+5 Status  Name Path I Connect I
(Z)  Definition_1 C:\Users\Ibarothy\Desktop\ATMENE
Connect Documert to ARCHICAD. . Definition_3 C:\Userslbarothy'\Deskiop \ATMENETI\Defi Cancel
Definition_2 C:\Users\barothy'\Desktop \ATMENET\Def
Export Quick Image...  Ciri+Shift+Q
@ Bwor Hi-fles Image
Documert Properties
Create User Object.
T Ribbon Layout ,
= < >
Show In Folder
& Special Folders v
Preferences. Cirl+Shift+P
Close Defirition_1 Cul-w

@ Autosave complete (11 seconds ago) 0.9.0076
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Preview Option in Grasshopper’s Display Menu

In Grasshopper, the Display menu contains a new toggle option: Detailed ARCHICAD Preview.
Turn this on to see a Preview of detailed, exact geometry generated in Rhino via ARCHICAD
Components, using the ARCHICAD element colors.

Grasshopper - unnamed -8

Display [ ARCHICAD | Fluc

[H2@® -~

@O BT rercra s — — - - =
& rAFLSELS S [— |+ || © strucura-gearing > s D coreoutsiae 1 | senericwans..»
Py @ ; ["500. Ground Floor] [WE x [[South Elevation] acRd
B &l [[ro0x No Prey Qe XS 0o X
@ Wreframe Preview a2 p—
(@ seisaprven a3 o = esshopper

Connected to: <no
docu

& Selected Oniy Preview

, [ Rhinoceros 5.0 Not For Resale Lab - [Perspective] -8

fon Transform  Tools Analyze Render Panels VisuslARQ Help

géﬁ@@@@ﬂ@%@@ﬂ@mmﬂﬁ

5%

Perspective  Top | Front = Right 4 DG @@ 4 |@ cumentzoom 0,00 @ 1100 »|£ o2Dwfting » [ Entire Model » | | 03 Architectu...»
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ARCHICAD Nodes

The ARCHICAD tab page in Grasshopper contains parameter nodes, input nodes and component
nodes. The parameters store geometric information; the input nodes provide access to certain
ARCHICAD value sets; the components perform the operations that generate data.

project. Using Grasshopper components, the referenced geometry can be

Parameter nodes refer to point coordinates or existing geometry in the ARCHICAD —— —
@06
transformed in the usual way, and can also be used as the initial input for GH code.

Currently, the ARCHICAD tab contains three Parameter nodes: 2D Curve, Point and Spline.

Currently, there are 20 Design Components available: Beam, Column, = Eﬁj‘ Di @@@ e Epji
Curtain Wall, Curtain Wall Boundary, Curtain Wall Segment, Door U E@I% Rla I PRES
Distance, Door Point, Mesh, Morph Curve, Morph Solid, Chair, Roof, EEE E'H @g@' ‘i;i’] EF'H
Shell Extruded, Shell Revolved, Shell Ruled, Slab, Wall, Window
Distance, Window Point, Zone.

Design Components generate native 3D elements in ARCHICAD:

At present, Grasshopper components cannot interpret the output from ARCHICAD components.
For this reason, Grasshopper operations (such as the Move component) cannot be carried out on
the geometry generated by the AC components. Thus, the AC components can be placed
downstream from the GH nodes, but the Grasshopper definition ends there.

Synchronize
Curve =3 Beam

Curve Points Beam Settings

Count Jﬂ Tangents Syhehtonize

Kinks Parameters Anchor Point
U Column
End Paoint

Curve Points

Count f Tangents
Kinks Parameters Synchronize %

Column Settings

(| Geometry oﬂo Geometry Curve % Beam
( Motion

Transform Beam Settings

GH Definition AC Components

Document Components generate native 2D elements in a 2D viewpoint of the —
ARCHICAD project connected to the GH code. (T A

In this version of the add-on, there are three Document Components available:
the 2D Curve, Fill and Spline.
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Settings Components are available for each Design and

Lol il 00 &0 S&I0  s&00
Document component. The Settings component defines the = @D T S m v
arameters of the element generated in ARCHICAD. Attach a e e [ e
ot A | % & 0 W[
Settings component to the “Settings” input parameter of the T T ST STl Sl =T <]
data-generating component. HHEH=2C Lo H

Reshape Components can modify elements produced by some =
of the ARCHICAD Components (Fill, Slab and Roof Component). Currently there are ﬂ =

two Reshape components: the Subtract Polygon and the Add Polygon.

Input nodes: An input node stores a list of values received from

ARCHICAD. The available values are continuously refreshed, so that they
always correspond to the set of values contained in ARCHICAD. At

present, twelve input nodes are available: 2D Viewpoint, Composite, Fill
Pattern, Line Type, Profile, Surface, Building Material, Favorite, Layer,
Pen, Story Plane and Zone Category.

Place ARCHICAD Nodes

The ARCHICAD (AC) nodes available on Grasshopper’s ARCHICAD tab work the same way as
other components or parameters in Grasshopper. Use the familiar methods to place them on the
Grasshopper canvas. After the necessary input parameters are received, a preview is
immediately visible in the Rhino window.
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ARCHICAD Parameter Nodes

The AC Parameter nodes refer to points or existing elements in the ARCHICAD project. AC
Parameter nodes are an integral part of the Grasshopper code, because the Grasshopper code
recognizes them as Geometry-type input data.

AC Point Parameter Node

Like Grasshopper’s Point parameter, the ARCHICAD Point
parameter (AC Point) can store 3D point data. This data is @

defined in ARCHICAD, not in Rhino. The AC Point parameter |z°im_ | &
can reference a single or multiple 3D points. & E;:::
& Bake..
Setting one point: Q Runtime warnings 3
1. In Grasshopper, right-click on the center of the AC Point. Wire Display N
2. Select ‘Set One Point” in the context menu. (The Rhino :""'e“e
atten
and GH windows close. In ARCHICAD, notice that the ot
Status Bar displays the message: “Click a point”.) D Smply
3. Click in the ARCHICAD window to define the origin of the Set one Point in ARCHICAD
AC Point. (If the point is selected successfully, the Rhino Set Multiple Points in ARCHICAD
and GH windows appear again, and the parameter node Clear values
turns from yellow to gray, to indicate that it is not empty.) Internalise data
4. Now continue working as needed in ARCHICAD, or return ] Bxrsct parameter
to Grasshopper. W el

Note: The value stored in the parameter node can be redefined at any time using the “Set One Point”
or “Set Multiple Points” commands.

Setting multiple points:
In Grasshopper, right-click on the center of the AC Point.

N

Select “Set Multiple Points” in the context menu.
Click several times in the ARCHICAD window to define a collection of points.

W

Press ESCAPE on the keyboard to exit input mode.

umv cmn { Geometry o Geometry t

{ Mation Transform

C ) ¢ D .
n j Start Point / _— F

End Point

@ Point

Contains a collection of three-dimensional ARCHICAD point coordinates.

One locally defined walue..
Point
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ARCHICAD Nodes

Note: The AC Point component converts a point defined in ARCHICAD into a Grasshopper Point
parameter. Thus, the AC Point parameter node can be assigned to any GH component that requires a
GH Point-type input.
To define the origin of an AC Point, you can also click on any hotspot of a placed ARCHICAD
element. In this case, the AC Point will remain associated to its parent element in ARCHICAD.

For example:
1. In Grasshopper, place two AC Point parameter nodes.

2. To define their origins, go to ARCHICAD and click the endpoints of an already placed Beam
element.

3. In ARCHICAD, move the Beam to a new position.

Click the ‘Send Changes’ button on the Grasshopper Connection Palette: the coordinates
stored in the AC Point parameters are modified to match the Beam’s new position.

2D Curve Parameter Node

2D Curve Parameter can reference one or more 2D elements drawn in ARCHICAD with the Line,
Polyline or Circle Tool.
Note: You can use the 2D Curve parameter to reference any Polyline or Circle element drawn in a 2D

ARCHICAD Viewpoint. However, in Grasshopper, the new planar shape will always be drawn in the XY
plane.

Referencing a polyline in ARCHICAD:
1. Draw a polyline in ARCHICAD with the Polyline Tool.
2. In Grasshopper, place an AC 2D Curve parameter and right-click on its center.

3. Select ‘Set One 2D Curve’ from the context menu. (The Rhino and GH windows close. In
ARCHICAD, notice that the Status Bar displays the message: “Click an element”.)
Note: If any ARCHICAD elements are selected at the time you issue the ‘Set One 2D Curve’ command,
and if the set of selected elements includes one element drawn with the Polyline/Line/Circle Tool, then
the parameter is automatically defined according to the selected element, and no further element
selection is needed. If the selection does not include a Polyline/Line/Circle element, or if there are
multiple selected Polylines/Lines/Circles, then the program will deselect the elements, and prompt you
to select elements in ARCHICAD.
4. Click on the previously drawn polyline in the ARCHICAD window. The 2D Curve parameter is
now referencing the selected ARCHICAD element.

The 2D Curve parameter remains associative to its parent element in ARCHICAD. After editing
the referenced polyline in ARCHICAD, press the ‘Send Changes’ button on the Grasshopper
Connection Palette to update the information stored in the 2D Curve parameter.

Note: The AC 2D Curve parameter is compatible with the GH Curve parameter. Thus, it can be used as
the input for any GH component that accepts the GH curve type as an input.
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Naturally, you can use the 2D Curve parameter to reference multiple ARCHICAD Polyline, Line or
Circle elements. To do this, use the “Set Multiple 2D Curves” command from the context menu.

Note: If any ARCHICAD elements are selected at the time you issue the “Set Multiple 2D Curves”
command, and if the set of selected elements includes at least one element drawn with the Polyline,
Circle or Line Tool, then the parameter is automatically defined according to the selected element, and

no further element selection is needed.

Spline Parameter Node

Works exactly like the 2D Curve Parameter node, but only stores elements created with the

ARCHICAD Spline Tool.

Modify Information Stored by Parameter Nodes

The content of parameter nodes in ARCHICAD can be redefined, deleted or updated at any time.
To redefine the stored value, use the “Set One Point” or “Set Multiple Points” commands from

the context menu.

¢ To clear the parameter values entirely, use the “Clear Values” command from the context

menu.

¢ Information stored by the parameter node is not updated automatically if the referenced
element has been changed in ARCHICAD. To update the GH code with changes made in
ARCHICAD, click “Send Changes” on ARCHICAD’s Grasshopper palette.

Grasshopper-ARCHICAD Live Connection User Guide
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The Synchronize Parameter

All AC Components — except Settings Nodes —include “Synchronize” as an input parameter. Itis a
Boolean type parameter which enables components to communicate with ARCHICAD. If a

component’s Synchronize parameter is set to be TRUE, changes made to that component will be
synchronized with ARCHICAD automatically.

| |

Synchronize @ Synchronize
Curve % Beam Synchronize with ARCHICAD
. TRUE = changes made to the component will be synchronized with ARCHICAD automatically.
Beam Settings

FALSE = the component does not communicate with ARCHICAD

One locally defined walue..
Trus

Note: Synchronization works only if ARCHICAD’s Grasshopper Connection is on: that is, the green icon
on the Grasshopper Connection Palette is spinning.

20
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The Settings Parameter and Settings Nodes

Each Document and Design Component (which generate new elements in ARCHICAD) includes a
Settings input parameter. Use the Settings component to define the parameters and attributes of
the new ARCHICAD element. You can attach two types of nodes to the Settings input parameter:

¢ |f you will control all of the new element’s parameters from Grasshopper, attach the Favorite
Input Node to the Settings input parameter (see Input Node for more information).

¢ |f you want to control only certain of the new element’s parameters from Grasshopper, then
attach the Settings node (Wall Settings, Slab Settings, etc.) that corresponds to the type of
generated element to the Settings input parameter.

It is not necessary to use the Settings input parameter. In this case, the newly generated element

will use the current Default Settings of its corresponding tool in ARCHICAD.

Each ARCHICAD element type has a Settings Node. Each input parameter on the left of the
Settings Node corresponds to a parameter in the ARCHICAD tool settings dialog box (although
there are fewer parameters in the Settings Node). It is not necessary to define any of the Settings
Node input parameters in Grasshopper. If any parameter is left empty in Grasshopper, the
generated ARCHICAD element will use the default value of the corresponding default Tool
Settings dialog box.

The right side of the Settings node has a single output parameter, which transfers the input data
to the Design or Document component.

In many Settings Nodes, you can change the type of the generated element, using a context
menu command. As a result, the set of input parameters available to the Settings Node will
change (that is, new parameters appear on the left side of the node, and others are removed).

Any upstream nodes that were formerly connected to a removed parameter will be
disconnected. Disconnecting nodes is not undoable. Therefore, the program displays a warning
when you issue a command that will remove an input parameter. To avoid disconnecting nodes,
you can press Cancel.

q Building Material
q Height
Number Slider 00250 ])-—_( Thickness
E] Outside Slant Angle
@ Inside Slant Angle
&
Layer DD Wall Settings
[[>]

A A A~ A A A A A

Structural Function WallSetB &y Break Connections
Position [@ Enabled

. Asthe resul of changing the Structure. any nodes
Renovation Status & Bake.. ] connected to the following input parameters will be
= Suien connected:

roper
# Structure » Basic - Thickness
Geometry Method of ARCHICAD Wall  » ‘JE]_ Composite
F ComplexProfile Cancel
@ Help.
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The Property Settings Node
(Controlling Metadata)

The Property Settings Node provides access to the Element Properties defined for ARCHICAD

construction elements. With this node, it is possible to define or overwrite these ARCHICAD

property values in Grasshopper.
Note: Use ARCHICAD Properties to add optional descriptive data to a building element. In ARCHICAD,
you can list and manage them in the Interactive Schedule, display them in Labels, Zone Stamps, Door/
Window Markers, import and export them among applications or to spreadsheets. Use the Property
Manager (Options > Property Manager) to create and delete properties and customize their
availability. Each element’s Properties are shown in the Categories and Properties panel of Element
Settings.

() Wall Selection Settings ? () Property Manager ?
T

W Selected: 1 Editable: 1 7] [ wan P Nome: Editable; 0
name Type Default

= GENERAL RATINGS +

% Fire Resistance R... Option Set 25 minutes ~ DEFINITION

~ O! GEOMETRY AND POSITIONING

Wall Top:

7. story (rome = 1) Y| alAla

GenericWallsnell ,
_— | = 5 sou o =

~ MAIN CONSTRUCTION +
e = P 4 Construction Type Option Set Undefined
4 o oz n

Home Story:
0. Ground Floor (Current) v

to Project Zero | » AVAILABILITY

d o

+ [z FLOOR PLAN AND SECTION
» £ MODEL
« [E] CATEGORIES AND PROPERTIES

Element Classification: Wall I3
[ show coniicts with Properties In Hotlinks

Show On Renovation... All Relevant Fifters ~
. CENERAL RATINGS New. Delete N Cancel
Fire Resistance Rating 25 minutes
Combustiole False
Thermal Transmittance Undefined
Sound Transmission .. 25
- MAIN CONSTRUCTION
Construdtion Type  Undfined
- IFC PROPERTIES

e8ds

8

Ifewallstan:

< Struttural - Bearing > Cancel

When first placed, the Property Settings node has no parameters. To select properties, use
“Select ARCHICAD Properties” from the component’s context menu. In the appearing dialog, first
choose an Element Classification: this will determine which Properties can be assigned to the
generated element.

Note: Element Classification is used to precisely define the function of an element, so that the
ARCHICAD model is interpreted accurately when exchanging data with other applications, e.g. using
the IFC standard. Each element has a default classification that corresponds to the tool type (e.g. an
element created with the Slab tool has a default classification of “Slab”), but this can be overridden in
ARCHICAD on the Categories and Properties panel of Element Settings.

Once the Element Classification is defined, the dialog lists only those Properties that are
available for assignment. Check the box of the Properties you wish to assign, then click Select.
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The selected Properties now appear as new input parameters on the left side of the Property
Settings node.

Select ARCHICAD Properties - © HESN

V' Blement Ciassfication: Wall v

Q Search Property

Name Type
GENERAL RATINGS

[ Fire Resistance Rating Option Set

Combustible True/False

] Themal Transmittance General

40 Property Settings [ Sound Transmision Ciass General
S o MAIN CONSTRUCTION e BT SEHITE
. Element Classification [ Construction Type Option Set Boolean Toggle (2= Combustible "®
- =

Fropery Settings & ‘ Element Classification 3

(@] cEnabled

& Bake.

Select ARCHICAD Properties.

@ Help. ‘

Cancel Select

An ARCHICAD Property has one of six possible Data Types:

e General: Simple text; corresponds to Grasshopper Text

e Integer: A whole number; corresponds to Grasshopper Integer

e Number: Any real number; corresponds to Grasshopper Number

e True/False: Logical value; corresponds to Grasshopper’s Boolean

e Tags List: A series of words or phrases; used to make it easier to search for elements that use
such tags. In Grasshopper, this is achieved by assigning a series of Texts separated by semi-
colons.

e Option Set: A list of text values. The user can choose one or more of these defined options
(multi-choice). In Grasshopper, this is achieved by entering the number of the option(s) to be
assigned to the Property, based on the info shown in the tool tip.

(1 Property Manager v "
» :W 2 . . . A0 Property Settings
v & \ome: Editabie: 1 Fire Resistance Rating '® o
Name Toe Detauit Fire Resitance Roting lement Classification
~ GENERAL RATINGS + A @ Fire Resistance Rating

~ DEFINITION

Faise
Undefined Data Type: Option set v

2
Preview/Default: 25 minutes v

Undefined
Undefined
Undefined

DOAMMATY A Options Setup ?
0w

4B ..
DoAY » AVAILABILITY
Undefined

WL QTaphsOft...

Undefined

DOMMATY

Add Remove | [[]Allow multiple choiees

Note: Whether an Option Set is multi-choice or single-choice is defined by the user in ARCHICAD, using
the Data Type - Option Setup choices at Options > Property Manager.

If the Option Set is multi-choice, then in Grasshopper, the Property Settings Node will expect multiple
inputs in the form of “Integer as List”. (If you input multiple integers here, then multiple values are
assigned to the Property, and the Property Settings Node generates one output). If the Option Set is
single-choice, then the Property Settings Node generates a separate output for each input Integer.
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Note: It is not possible to create a new ARCHICAD Property in Grasshopper; you can only assign values
to existing Properties. If you need a new Property, you can create it from ARCHICAD’s Options >
Property Manager dialog. Grasshopper is immediately updated with this new information: the next
time you open the Select ARCHICAD Property dialog, the newly created Property will be listed.
The Property Settings Node’s first output parameter is “Property Settings” type. You can use this
as an input for the Settings nodes of 3D elements.

The second output parameter is “Element Classification”. Use it to add a Panel node, so you can
see the name of the Element Classification chosen in the Property Settings node.
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ARCHICAD Document Components

Document components generate 2D documentation elements in ARCHICAD. There are three
Documentation elements so far: the 2D Curve, the 2D Fill and the 2D Spline component. All of
them have two required input parameters: the Curve parameter defines the shape of the newly
created planar element, while the 2D Viewpoint parameter determines the 2D Viewpoint
(Section, Floor Plan etc.) of ARCHICAD onto which the new element will be placed. Use the input
node entitled 2D Viewpoint to choose the desired Viewpoint. This is a special interface item
which contains a continually updated list of planar Viewpoints in the current ARCHICAD project.
Note: ARCHICAD’s documentation elements — such as those created by the Fill, Line, Circle, Spline and
Polyline tools — are not visible in 3D views, only in 2D views (Floor Plan, Section, Elevation, Interior

Elevation, etc.). Therefore, only 2D viewpoints can be used as the input parameter for the 2D Curve
and 2D Spline Components.

Choosing the Viewpoint:

1. Place a 2D Viewpoint input node, then connect it to the “2D Viewpoint” input parameter of
the 2D Curve or the Fill component.

2. Click on the right side of the input node. A tree structure appears, corresponding to the
ARCHICAD project’s Project Map.

3. Choose the desired Viewpoint, then click Select.

Synchronize

Synchronize

Fill Settings (Ere R @ SR
Curve

0.Ground Floor D

Note: The 2D Curve and Fill components will accept only curves lying on a single plane as inputs. The
input curves defined in Grasshopper can also be planar splines, but ARCHICAD will segment these,
creating segmented Polylines.
At present, it is not possible to attach additional GH components to the right side of the
Document components (e.g., you cannot transform them with the Move component), because
the data output by the Document components are not recognized by the GH components.
However, Fill-type data created with the Fill component can be used as input by Reshape
components (Add/Subtract Polygon).

2D Curve Component

This component generates curves (defined in Grasshopper) in a selected 2D Viewpoint of the
ARCHICAD project. The curves created in ARCHICAD will be Polylines. If you want to define the
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ARCHICAD Layer, the Line Pen or Line Type of these Polylines, attach a Polyline Settings
component to the input parameter to the 2D Curve Component Settings.

Navigator - Project M... n

2 [@moa
2 (B Untitled ~
[ stories
[ 2. story
5 1. stery
[ 0. Ground Floor
53 Sections
T Elevations
[I] interior Elevations
Worksheets
(& petails @

< >

- Synchronize
(T3 | 0.Ground Floor D
. ! Curve

2D Viewpoint

a 2D Curve

Polyline Settings

~ Properties
Lo | Ground Floor |

| Settings... |

2D Spline Component

This component works the same as the 2D Polyline Component, except that it generates Spline
elements in ARCHICAD. The Spline Settings node, in addition to Pen and Layer options, includes
two Boolean (TRUE/FALSE) options: you can choose to generate a normal vs. Bézier curve, or
Open vs. Closed-ended Spline.

Spline (Locked) Synchronize

Layer: 2D Drafting - General

Curve

/Ln spline

( 2D Viewpoint

d Spline Settings

2D Fill Component

The Fill component will create Fill elements (that is, 2D hatches) in ARCHICAD. Like the 2D Curve
component, the Fill component has two required input parameters: a Curve and a 2D Viewpoint.
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Use the Fill Settings Node to define the attributes of the generated element (use the Pen, Line

Type and Fill Pattern input nodes), its Layer (use the Layer Input Node), and/or to show its Area
Text.

Plane
Polygon D

Radius
Segments
Fillet Radius

[TH| 0.Ground Floor D

Length -
( Synchronize

Curve

ZA, 20Fil

g 2D Viewpoint
Fill Settings

Note: Right-click the Fill Settings component
to open the context menu, where you can
define the Fill category of the newly created
Fill element. If you choose “Cut — Building
Material”, then you can use the Building
Material Input Node (instead of the Fill
Pattern) to define the pattern of the Fill
element to be created in ARCHICAD.

Fill SetM B

Enabled

Bake...

Category of ARCHICAD Fill. v Drafting

Help.. Cover

Cut
Cut-Building Material

gy o
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ARCHICAD Design Components

The Design components generate native 3D elements in ARCHICAD. Their input parameters must
be geometric information (point, curve, etc.) which define the new elements’ position. Most of
them have a single output parameter which stores geometric information.

The outputs of AC Design components currently cannot be used as inputs for the transforming
components in GH (such as Move). For some components, however, the output data can be re-
used as inputs for other AC elements (for example, the Window component requires a Wall-type
input, the Reshape Components accept Fill, Slab and Roof type inputs).

Synchronize { Synchronize
Curve O Roof Single-plane Geometry ﬂ Geometry
( Roof Settings (¢ Curve

Synchronize q synchronize
Curve & > Slab Wall
; : B Window |
Slab Settings { Horizontal Distance
¢ Window Settings
Synchronize
synchronize
Curve [j Wall y &
; Wall
Wall Settings D Door
Horizontal Distance

Door Settings

Synchronize

Curve t:Q] Beam

( Beam Settings

Important: If a Grasshopper component (e.g. Slab) is assigned multiple curves as input parameters,

then ARCHICAD will generate a corresponding number of Slabs, each of which is separately editable in

ARCHICAD
To refine the component geometry or control attributes, you can attach the corresponding
Settings Node to the Settings input parameter of the Design Component. By default, parameters
of the Settings Nodes initially inherit the values set in ARCHICAD, in the Tool Default Settings
dialog of the corresponding tool. Use familiar methods to override default values in Grasshopper

(e.g. attach a Number Slider component).
¢ Synchronize
¢ Curve l:j wall D
¢ wall settings

Building Material
Height

[ Number Slider i Thickness
E] Outside Slant Angle

E] Inside Slant Angle

Layer ﬁ ‘Wall Settings
1D

Structural Function

@"@ <@> ARCHICAD Layer

Position
Renovation Status
Property Settings

f\f\f\AAI
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Note: Many ARCHICAD-based parameters of design elements are not yet available for Grasshopper’s
AC components. The value of these parameters, at the time the component is first generated, will
equal the current default value set for the corresponding tool in ARCHICAD.

Column Component

The AC Column component requires two points as input parameters. Based on these,
Grasshopper will generate ARCHICAD columns along the defined segments (which serve as the
column axes).

Structure: GENERIC - STRUCTURAL
Base Hevation: 0

Layer: Structural - Bearing
Story: 0. Ground Floor

Synchronize
Anchor Point
End Point
Column Settings

U Column D

Attach a Column Settings Node to the Settings Input of the Column Component to control the
Building Material, Layer and additional geometric parameters of the generated elements.

Through the context menu of the Settings Node,
you can define the column profile (Rectangular,
Circular or Complex Profile).

Notes:

* You can also attach an AC Point parameter to the
input parameter of an AC Column component,
because AC Point data is compatible with GH
Point data.

e Defining the end point of the Column is optional.
If you leave it undefined, you will get a straight
column with default height (the current height set
in the Column Default Settings dialog in
ARCHICAD).

[ColumnSetR 8
Enzbled

& Bake..
Structure of ARCHICAD Column » Rectangular

@ tep €3 Circular

GE  ComplexProfile

Slab Component

The AC Slab component generates an ARCHICAD Slab element. The required input parameter is
one or more closed curves. Because ARCHICAD can interpret only horizontal slabs, the input
curve(s) must be in the XY or parallel plane.

The input geometry may be:

e a Grasshopper Curve parameter referencing one or more selected closed curves in Rhino,
e any component on the Grasshopper Curve tab that generates a closed curve,
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e a 2D Curve parameter referencing a closed ARCHICAD polyline element.

ructural - Bearing
Ground Floor

L { Synchronize
Polygon  [e=( Curve a Slab
¢ Slab Settings

Plane

Radius

Segments
. . Length
Fillet Radius

=Y

Important: In Rhino, you can select a curved spline as the input parameter for the AC Slab component,

but the outline of the corresponding Slab generated in ARCHICAD will be segmented.
Use the Slab Settings Node to access additional parameters. Open the context menu of the
Settings Node to define the Structure (Basic or Composite) of the generated Slab elements; the
set of available input parameters will change accordingly.
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Wall Component

The AC Wall component generates ARCHICAD Wall element(s), based on one or more lines,
polylines, or open or closed curves. The input geometries must be in the XY or a parallel plane.

—A\

¥y

- Beari
Story: 0. Ground Floor

¢ Synchronize
1(E,> ¢ Curve D Wall D
¢ Wall Settings

Important: If you select a Rhino spline as input curve parameter for the AC Wall component, then the
resulting element in ARCHICAD will not be a single curved Wall, but rather a chain of Walls, whose
segments correspond to the spline segmentation.
To access additional parameters — such as Layer, Height or Building Material — connect a Wall
Settings Node to the Settings input parameter of the Wall Component.

The Structure (Basic, Composite or Complex
Profile) and Geometry Method (Straight or
Trapezoid) of the generated Wall elements can be
set through its context menu. The Structure and
Geometry Method values influence the available
set of input parameters in the Settings Node.

WallSetB B

Enabled

Bake...

Structure

‘ Basic

Geometry Method of ARCHICAD Wall 3 JE]_ Composite
Fh Complex Profile

Help..
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Beam Component

The AC Beam component generates ARCHICAD Beam element(s) along one or more lines,
polylines, or open or closed curves. These curves may be in 3D space.

Beam (Selected) (Locked)
Structure: GENERIC - STRUCTURAL
[

To
Width 500
Layer. Structural - Bearing
stow;: 0. Ground Floor

=

( Synchronize
g Curve =37 Beam D
( Beam Settings

Important: 3D curves will be segmented in ARCHICAD. Therefore, the geometry generated by the AC
Beam component will produce not a single curved Beam, but rather a chain of beam segments “stuck

together”.

Attach a Beam Settings Node and open its context
menu to decide what kind of cross-section the

generated Beam elements should have
(Rectangular or Complex Profile).

According to this choice, the Settings Node will

contain further parameters, such as Profile

Rotation, Axis Offset, and Building Material.

Morph Components

There are two kinds of Morph components:

Enabled
& Bake.

prit

| Structure of ARCHICAD Beam 3 Rectangular
9 e

e The Morph Curve component transforms the Curve from Rhino into an ARCHICAD Morph

curve.
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¢ The Morph Solid component transforms Mesh geometry from Rhino into a solid ARCHICAD
Morph.

Morph (Locked)
Bevation: 0
o Layer: Morph - General

Stowy: 0. Ground Floor
: ¢ Synchronize
< || ¢ Curve @ Morph

¢ Morph Settings

Morph (Locked)

Synchronize
q Mesh Gé Morph D
{ Morph Settings

Ri’ﬁp ' e Synchronize
Settings Mesh (|~ Morph

Settings
Wire Display »

@ Principal

B Reverse

Flatten

Graft

[ Simplify

b Set Mesh Options
Manage MeshParameters collection
Clear values
Internalise data

Extract parameter

@ Help...

With the help of the Morph Settings Node, you can assign a Building Material to your newly
generated Morph element, and you can decide which ARCHICAD layer it should appear on.

Note: In Grasshopper, you can also use Box, Surface, or BREP-type values as Mesh inputs for a Morph
- since these values are converted into the Mesh type automatically. When using BREPs, it is
recommended to also use the “Mesh-Brep” converting component in GH, to help keep polygon count
under control.

Note: The Weld Edge information is stored in the Morph component. Thus, the Weld Edge information
applied to the input Mesh will also be applied to the Morph element generated in ARCHICAD.
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Roof Component

The Roof component requires a single Curve-type input parameter for generating an ARCHICAD
Roof. This input curve can lie in any plane, thus defining not only the roof contour but also its
pitch and elevation.

Roof (Locked)

Structure: Tile - Roof
Pivot Line Hevation: -330
Roof Pitchy 24,44
Thickness: 330
Layer: Shell - Roof
Story: 0. Ground Floor )

Plane
Radius
Segments

d Synchronize

Curve (7 Roof Single-plane

You can determine the Structure type (Basic or Composite) of the element through the context
menu of an attached Roof Settings node. Depending on the selected Structure value, the
Settings node will include Composite or Building Material as input parameter.

Note: The polygon used for the Curve input defines the 3D location and plane of the Roof element

generated by the Roof component. Thus, the Offset from Home Story and Roof Pitch parameter values
(stored in the Favorites of the Roof Settings input) have no effect.

/) Roof Selection Settings ?

kg Selected: 1 Editable: 1

~ DI GEOMETRY AND POSITIONING

::::1 B w

Home Story:
0. Ground Floor v L
bl
. to Project Zera| ¥
- /% G
4 ("-:;;\ MULTI-PLANE GEOMETRY
L4 % FLOOR PLAN AND SECTION
v » MODEL
] CATEGORIES AND PROPERTIES
> Shell - Raof 3 Cancel
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Shell Components

The ARCHICAD Shell tool has three Geometry Methods - Revolved, Extruded, and Ruled. The AC
Connection Add-On provides a separate component for each of these. Each component has two
required input parameters, whose type is either Curve, Vector or Axis.

[l (A Generic Wall/Shell Synchranie

Profile Curve
( Extrusion Vector
( Shell Ext. Settings

Stary: 0. Ground Floor

7 shell p

Synchronize

d First Profile Curve Shell
v’ el D
{ Second Profile Curve

( Shell Ruled Settings

Synchronize

Profile Curve

() shell D

Revolution Axis
Shell Rev. Settings

Each of the three Geometry Methods has its own Settings Node. Use the Settings Node context
menu to define the generated element’s structure: Basic or Composite. In addition, you can use

the Settings Node parameters to fine-tune the Shell geometry or define its Building Material/
Composite attribute.

Mesh Component

This component generates an ARCHICAD Mesh element based on the 3D coordinate set it
receives as input. The input must consist of a set of at least three points.
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Use the Mesh Settings node to define Building Material, Height, and Layer. Use the Structure
input to set the Mesh display as either Solid or Surface only.

Mesh (Locked)

Base Hevation: -1000

Layer: Site 8 Landscape - Terrain
Story: 0. Ground Floor

Building Material
Height
Structure
Layer

. % Mesh

( Mesh Settings
Boundary

Curtain Wall Components

To generate a Curtain Wall element from Grasshopper, you can use three different components.

e Curtain Wall component: Generates a Curtain Wall by an extrusion of the reference line
(defined by the Curve input). The extrusion is perpendicular to the plane of the Curve input.
The height of the generated Curtain Wall is defined in the Domain input, and its external side
is defined by the point-input value of the same name.

 Synchronize

Curve

Domain iﬂﬂ Curtain Wall

Note: Use the Construct Domain Grasshopper component to define the Domain input parameter. If
the Domain Start parameter value is negative, then the extrusion will also extend below the reference
line (in the negative Z direction). Example: If the Domain value is “-2 to 3”, then the generated Curtain
Wall will be 5 meters in height, and will begin at a point two meters below the reference line.

e Curtain Wall Segment component: Works similarly to the Curtain Wall component, but here
you can only create a single Curtain Wall segment (its input reference line is a Line, rather
than a Curve). The component also requires a Plane Point input parameter. The extrusion
takes place perpendicular to the reference plane defined by the Line and Plane Point inputs.
The Plane Point also defines the Curtain Wall External Side.
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Line input: reference line of Curtain Wall

Plane Point input: point defining
(together with the reference line)
the reference plane of the extrusion.

Reference plane (the extrusion takes
place along the normal of this plane)

XY plane

A4

e Curtain Wall Boundary component: Generates a Curtain Wall element with a Boundary of a
freely defined shape. Its plane and shape is defined by the closed polygon given as the
Boundary input parameter. Here, too, an input point defines the External Side.

¢ Synchronize

{ Plane —
Circle Eeincag i
ol Curtain Wall
I External Side EE
¢ CW Settings

The CW Settings component can be attached to any of the three CW components. Additional
Settings components can be attached to these in turn, as needed.

e Use the Scheme Settings component to define the grid pattern of the Curtain Wall Element.
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e Use the CW Frame Settings component to set parameters for Mullion, Transom and
Boundary frames.

e Use the CW Panel Settings component to set parameters for the Main and Distinct panels.

( CW Settings

Zone Component

The Zone Component generates spatial units in your Project used to represent rooms; wings of a
building; blocks of a housing estate; or functional areas of a building. ARCHICAD Zones in 3D can
also be used for simple mass modeling; they also form the basis of the Model Review process in
the Energy Evaluation function.

A Zone Component requires two inputs:

The Curve input determines the Zone’s shape, while the Stamp Position defines the location of
the Zone Stamp.

The content of the Zone Stamp can be input using the Zone Settings Node. Connect additional
inputs to the Zone Settings Node to assign metadata and attributes to the generated Zone.

See the sections on The Property Settings Node (Controlling Metadata) and the Zone Category

Input Node.
( Synchronize
d Curve
. [23 Zone )
d Stamp Position
( Zone Settings

( Vertices
#2 polyline D
( Closed

Generic

0 GROSS AREA

Office
Production & Research

7
2

3

4 Stormge d Sales

5 Education & Cukture

6 Medical Treaiment

7 Other Usage

8 Techrical Equipment

3 Communication & Access

DEEOEOOOEOCE

38 Grasshopper-ARCHICAD Live Connection User Guide



ARCHICAD Nodes

Note: By default, Zones in ARCHICAD are visible only on the Floor Plan. To see them in the 3D window,
go to View > Elements in 3D View > Filter and Cut Elements in 3D, and check the Zone item under

“Element Types to Show in 3D”.

I Filter and Cut Elements in 3D ?

Stories to Show in 3D

() Limited: Ta

From

Trim Elements to Story range

Marguee Effect

Show Elements:

(®) Inside Marquee

() Outside Marquee

[¥] Trim Elements to Marquee

Cut Surface Display
(®) Use Element Attributes
() Custom
ﬁ -
Element Types to Show in 3D
Window
Door
Skylight
Object
Lamp
Slab
Mesh
Roof
Shell
Curtain Wall
Zone
Marph
Stair

AYRELRL 0T POE

Railing

Cancel

Object Component

f
w
=)

>

NENONEREERNERERF

(o]
E
£

AC Object components require a single input parameter: anchor point. The default Library Part
type depends on what is set in Object Default Settings. To place a different object, attach an
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Object Settings Node to the Object Component, and use “Select Library Part” from the context
menu.

Object (Locked)
Name Armchair 0120

Bace Hevation: 0 Synchronize
Layer: Interior - Furniture Ancher Point % Object
Story: 0. Ground Floor
( Object Settings
(Object Settings @‘
Enabled
d} Bake...
I Select ARCHICAD Library Part
l@ Help...

On the left side of the appearing dialog box, choose among the project’s loaded library parts. On
the right side, the selected object’s GDL parameters are displayed for your information.

Note: By default, Grasshopper cannot access the parameters of ARCHICAD Library Parts, so these
parameters are grayed out. However, you can modify a Library Part’s GDL code to allow Grasshopper
to access the object’s GDL parameters. For more information, see Accessing GDL Parameters of
ARCHICAD Library Parts.

Window and Door Components

Door/Window elements in ARCHICAD can only be placed into existing Walls — they cannot
“float” independently of a Wall. Thus, Door and Window components require a Wall-type input.

To create the Door/Window opening, the input data must include information on its location
relative to the host Wall’s reference line. You can define this in two ways: via distance or a point.

e The Door/Window Distance component defines the distance between the Door/Window
insertion point and the Wall's endpoint, along the Wall reference line.

e The Door/Window Point component defines the location of the Door/Window opening as a
point projected perpendicularly onto the Wall reference line.
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As described in the Object component, attach a Door/Window Settings Node to the Settings
input parameter of the Door or Window component, then open the Select ARCHICAD Library
Part dialog to choose an opening type.

Window (Locked)
Mame, Window 20
WIH: 800 / 1500
Sillto Story 0: 1000
Story: 0. Ground Floor

{ Synchronize

( Wall Settings Synchronize
Wall

; . B window
( Horizontal Distance

Window Settings
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ARCHICAD Reshape Components

Subtract Polygon Component

This component is used to cut a hole of any shape into an existing Fill, Slab or Roof element.
First, connect the element to be modified to the Geometry input parameter. Next, using the
Curve input parameter, define the contour of the hole as projected to the horizontal plane.

The output will be an element of the type defined in the Geometry input parameter, with a hole
init.

Plane
Radius

Segments @
Fillet Radius

Curve

Notes:

e The Curve input defines the contour of the hole as projected onto the horizontal plane. Therefore,
on a slanted Roof, the hole is created by intersecting the Roof with the straight prism defined by
the Curve input.

e If you input a Curve that falls outside of the element in which the hole is to be cut, then the
Subtract Polygon component will result in another copy of the element to be cut, in unchanged
form (no hole).

Add Polygon Component

This component works just like the Subtract Polygon component, except that it adds to the
contour of the Fill, Slab or Roof, instead of subtracting from it.
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ARCHICAD Input Nodes

Input Nodes are special interface elements that reference certain data from the ARCHICAD
project, making these data available to Grasshopper. The referenced data are continuously
updated. Input Nodes can be attached to Settings Nodes to control attributes — such as Building
Material, Composite, Pen etc. — or the destination Layer of the generated elements. An exception
is the Favorite Input Node, which can be attached (instead of a Settings Node) to the main Design
or Document component.

An Input Node is divided into two parts: click on its left side to select the Node itself; click on its
right side to modify its stored data.

Layer Input Node

= [T @ ARCHICAD Laver b
Layer Name Exension  *
Use the Layer Input Node to bring up the ARCHICAD layer g

set in Grasshopper, to define the layer where elements e e
generated by Grasshopper should be placed. The Layer oL docapeGened
selection palette also includes the layers’ status (show/

hide, lock/unlock and 3D display mode). Sort the layer list
as needed (click the top of any list column) to make layer
selection easier.

Interior - Stair
Annotation - Structure
Dimensioning - Structure
Annotation - General

2D Drafting - Hotspot
MEP - HVAC

MEP - Bectrical
Dimensioring - Ste
Annotation - Label
Marker - Section
Structural - Shear
Structural - Bearing
Structural - Combined
Interior - Lamp

Nearly all Settings Nodes include a Layer-type input
(except the Settings Nodes of CW Panel and CW Frame).

PPPFIIIIPRITTTTTT T
000000HH000000000Q

Cancel Select

Fill Pattern Input Node

Through this Node, the Fill Type attributes of the current ARCHICAD project are made available
to Grasshopper. This Node provides ARCHICAD Fill Pattern-type data. At present, only the Fill
Settings Node can use this type of input. Use it to control the Fill pattern of elements generated
by the Fill component.

%% Concrete Block
VECTORIAL FILLS
Scaleindependent

d Synchronize F#77/77|Common Brick W Face Biick ~
P Fire Brick 77 masorry Block

s % 2D Fill [ Structural Concrete
d 2D Viewpoint [F5 7 ightweight Concrete [

= Hoypsum
Fill Settings V7] steel
F777) Brass/Bronze
77 Rubble
== Rigd Insulation
EZZ Wiood

i insulation 02

Pattern
Show Outline

Outline Type
Outline Pen

T
i

id + Dot&Dashed
DotdDashed

%
/7 Double 1:4 [ Double 1:8

B3 Trangular Grid = Triangles

gonal i Grass

Facing Tile - Large Scale 777 Rubble - Large Scale i

Cancel Select
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Note: The Fill Pattern Input Node can be attached to the Fill component only if you have selected other
than the “Cut Fill — Building Material” category from the Fill component’s context menu. For more
information on Fill categories, see helpcenter.graphisoft.com.

Pen Input Node
p ||__rTI- 0.35mm / 0.99 Pt - Annotation - Markers
Accesses the Pen attribute set of the connected EEE . BEEEEEEEEEE -
ARCHICAD project. Currently, this Input Node is R EER B mEEEE B ®
available for the Fill, Polyline and Spline Settings e
Nodes. L |
EANEEENEEEEN e
| ENEEEEE .

Line Type Input Node

Lists the Line Type attributes of the ARCHICAD
project. Currently, the Fill, Polyline and Spline Settings Nodes accept this type of data.

Cancel Select

Surface Input Node

Accesses the Surface attribute set from the connected ARCHICAD project. Currently, this Input
Node is available for only the CW Frame Settings and CW Panel Settings components.

Building Material Input Node

Lists the Building Material attributes of
. Z V Brick - Structural
the ARCHICAD project. I & om
7 Brick - Common Bond
Most Settings nodes of 3D elements QE oS %g oSy e 2
includes this type of input. Elements that E Bk - Frish
. . Concrete R Concrete - Structural
can have composite or profile structures ga Concrete Hock - Filer %E Conerete Bock - Sructual
. Fiberboard Fire Proofing
(Wa”, Slab, She”, ROOf, Beam, etC.) will (1 [l GENERIC - ENVIRONMENT EO GENER\C-DE)CI'ERNALCLADDING
. o g . 71 [[] GENERIC - EXTERNAL FILLER £ [T] GENERIC - EXTERNAL MEMERANE
InCIUde the BUIIdmg Materlal InpUt NOde £ I GENERIC- INSULATION [] I GENERIC - INTERNAL CLADDING
only if the Structure value is set to Basic. e T |1 s e
If the Structure value is set to Composite £l o= ] L] Gypoum Plateroard
. . D Gypsum Plasterboard - Waterproof D Insulation - Fiber Hard
or Comp|ex Prof”e' then the Profile or B [ Insulstion - Fiber Soft [T [ msulstion - Minersl Hard
B[] insulation - Mineral Soft F7 ] Insulation - Plastic Hard
% D Insulation - Plastic Soft @ . Insulation - Thermal Break
/Il ron /I Masorry Block - Filler
m . Masonry Block - Structural mTI . Membrane - Rainproof hd
Cancel Select
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Composite Input Node will be available instead, for defining the material of the generated

element.

Synchronize
Curve &> Slab
Slab Settings
| &
Enabled
Bake...
Structure of ARCHICAD Slab v [ Basic
Help... E2 Composite

Profile Input Node

Lists the Complex Profiles defined in the ARCHICAD project. Use it to define the cross-section of a
Wall, Beam, or Column element that has a Complex Profile structure.

Cq Precast Beam T

Synchronize
Curve % Beam
Beam Settings
BeamSetP &|

Enabled
Bake...

Structure of ARCHICAD Beam 3 | Rectangular

Help...

E Complex Profile

Click the right side of the Profile Input Node to open the
selection palette. Filter the list by using the element type
buttons at the top left corner of this palette.

Click the button at the bottom left to display the list by
either Icon or List format.

Note: If all three element-filter buttons are active at top left,
then you will see the full list of profiles. If only the Wall button
is active, then only the profiles available for Walls are listed.

Eitq Precast Beam T b :

(=]
Precast Beam T
300x 360
=3
i
S
ﬁ L [N
Brick Wall Belt Ledge Precast Double T
T
Bl A
Precast Beam T Precast Inverse  Precast Beam 102
Tee
Ve =1 (I v
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Composite Input Node

Lists the Composite attributes of the ARCHICAD project. This input parameter is available in the
Settings nodes of Walls, Shells, Roofs and Slabs whose Structure is set (in their context menu) to
Composite.

2D Viewpoint Input Node

Use the 2D Viewpoint Input Node to access the Viewpoints of the current ARCHICAD Project. By
attaching this node to the Document components (2D Curve, 2D Fill, 2D Spline), you can control
the 2D Viewpoint in which the 2D elements should be generated in the ARCHICAD project. Open
the Node’s palette to access a tree structure corresponding to the ARCHICAD Project Map. Note
that only the 2D views are available (Section/Elevation, Floor Plan, etc.); no 3D views are
available.

Mavigator - Project M... n

Il E | 0.Ground Floorb S N e

=I- Urtitled
- a [P Untitled l
Fl IE| Stories
5 1. story

E 0. Ground Floor

- North Blevation
i~ South Blevation
‘- West Blevation

ﬁ Sections
4 Q Elevations
Q East Elevation [Autc

T Morth Elevation [Au

1 South Elevation [AL

T West Elevation (Aut
@ Interior Elevations
Warksheets

(B etails
3D Documents W
< >
3 & X
Cancel Select b Properties

Story Plane Input Node

Produces horizontal planes (parallel to the X-Y plane) based on the Story heights of the
ARCHICAD project. Use these planes to define the reference input curves of the element-
generating components: this way, the elements (e.g. Wall, Slab, Beam) will be generated in
ARCHICAD at the correct elevations.
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synchronize

Curve &> Slab

slab Settings

Radius

|l a % List of Stories

No.  Name

2 Story

0 Ground Floor

Cancel || Select

Zone Category Input Node

Attach this Input Node to the Zone Settings Node to define the Zone Category Attribute of the
generated ARCHICAD Zone element.

The main function of Zone Categories is to use colors to visually distinguish different types of
spaces in your project.

Synchronize

Curve EIJ Zone

( Stamp Position

Closed

Vertices i
F Polyline D

¢ z
0 GROSS AREA Zone Settings

1  Residential and Recreation
2 Office

3 Production & Research
4 Storage & Sales

5  Education & Culture

6 Medical Treatment
7

8

9

OO

|

Cther Usage
Technical Equipment
Communication & Access

I

| Cancel || Select

Favorite Input Node
Lists the set of Favorites of the ARCHICAD project.

Note: In ARCHICAD, the Favorites feature allows you to save sets of configured tool settings by name.

For more information, visit helpcenter.graphisoft.com.
Unlike the other input nodes, the Favorites Input Node is attached not to the Settings Node, but
directly to the Document or Design Component (“Settings” input node) which generates the
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element. By attaching the Favorite Node (instead of a Settings node) to the Settings input node,
you are thereby defining all parameters of the generated element in one step.

Synchronize

Curve D Wall

Wall Settings

Ij Show Wall Favorites ‘ Wall Favorites
Column Favorites
[:J Wall - Bent Shel Beam Favorites
{:JJ ‘ga" - Foluzvda;ion Slab Favorites
tructural Wal
1 Partition Wal Roof Favorites

Generic Interior Wall Shell Favorites

Generic Exterior Wall Mesh Favorites

Morph Favorites
Window Favorites
Door Favorites

Object Favorites

Curtain Wall Favorites

CW Frame Favorites

CW Panel Favorites

Cancel Select

CW Scheme Favorites
Fill Favorites

PolyLine Favorites

SNN#EABSEFoBaLL 3 0 /=N

Spline Favorites

Note: The 3D position of elements generated by Grasshopper (such as the Offset from Home Story
parameter in the Settings dialog) are defined in the mandatory input data of the Document and
Design components, which generate the element. (For example, the elevation of a generated Slab is
determined by the Curve input parameter of the Slab component.) The Settings parameters which
define such mandatory input data are not affected by Favorite settings.
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Example 1: Use Rhino to Create Freeform Shading System

In this workflow, we create the geometry using Rhino’s freeform modeling capabilities, while
also taking advantage of ARCHICAD’s BIM capabilities. The task is to design a shading system that
extends between two curved splines.

1. Begin in Rhino: create the 3D curved splines.
2. In Grasshopper, use these freeform geometries as the input parameter.
3. Use the Divide Component to generate the division points needed for the shading system.

Curve defined in Rhino d —

(| Count ITangents
Kinks

[ Number of Division Points ‘ © 22
Parameters

| Curve Points

Count f Tangents

Parameters D

Curve defined in Rhino

Move

( Geometry o Geometry D

Factor h Unit vector D=(

Untitled - Rhinoceros 5.0 Not For Resale Lab - [Top] S
File Edit View Curve Surface Solid Mesh Dimension Transform Tools Analyze Render Panels VisualARQ Help

q Motion Transfarm D

Height of Facade

Curve or Edge to reference { Mode=Reference ). 2
Command: | L

B
A
@,
)

Era W
9, .

9.8,

=1

ok £

(2]
&‘ oe u
3 A

a X
T
= - -
oo Perspective . Top | Front | Right | +
CPlane X277 y-875 z000 Meters .Defau\t Grid Snap Ortho  Planar @ Osnap = SmariTrack = Gumball Record History Filter CPU

Top |
7

a8
oty

Splines drawn in Rhino with the Curve command
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4. At each division point, place an AC Column component; at each spline, place an AC Beam
component.

Synchronize

Curve =3 Beam
. e Beam Settings
Curve defined in Rhino { & b Curve
L5221 N, Couny I jlangents Synchronize
Kinks Parameters ) Pt Er e
End Point U Sl
Curve defined in Rhino ¢ &) | i

Synchrenize

Curve = Beam
Beam Settings

i Untitled - GRAPHISOFT ARCHICAD-64 20 = =

|| File Edit View Design Document Optiens Teamwork  Window  Help —ax
O-6-@Exxairrnanzee-

; ["S10. Ground Fioor] [Jiz0/am x {"J[South Elevation] ES |
. Desigr
|| B
1
(0 ‘
(=l |
{| &=
=

=

M OGCGEa|P & |Q curentzoom» | & 000 »|m 1100 »|£F o0z2Dratting » | B¥ Entire Model » | I 03 Architectu..» | (5] 03 Building .. » | G§  No Overrides »

Enter First Node of Wall. =}

Generated BIM model in ARCHICAD based on 3D Rhino curves

5. You can fine-tune the geometry in Rhino by adjusting the original spline geometry (use the
PointsOn command).

6. To define the Building Material attribute or Core Dimensions of the generated Columns,
attach a Column Settings node to the corresponding input parameter of the Column
Component.

Column Settings

Synchronize
Curve = Beam

/D vide Curve Beam Seitings Synchronize
Curve Paints Anchor Point

count J° Tangents e bt U Column
{ Kinks Parameters Column Settings

Divide Curve

Synchronize
Curve == Beam
Beam Settings
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Example 2: Use ARCHICAD Input to Build a Parametric Tower

In this workflow, parametric design is based on an existing ARCHICAD project, using input that
originates in ARCHICAD.

The task is to create a mass model of a high-rise atop a six-sided base, which has already been
defined in ARCHICAD.

1. In Grasshopper, use the 2D Curve parameter node to reference the six-sided geometry in the

ARCHICAD project.
2. Create an array of the polyline to draw the outline of the slabs on each story.

Polyline defined

in ARCHICAD
Number Slider
- Geometry
[ Height of Levels | 0 2.700
. Transform |
[ Nr. of Levels | ¢ 14
) 3_ParametricTower - GRAPHISOFT ARCHICAD-64 20 - o IEN
File Edit View Design Document Options Teamwork Window Help -0 x
oo @ g2 el e - - & B x| hew HLG S -
[} o ["S10. Ground Floor] x [D[aDJAm " inihd
7 om ildi i
st Building Site
~ Design n
Polyline
[ wan 2 Type: SolidLine
& Layer: 2D Draiting - General
D Door =
H  window -gg
[] cowmn &
=y Beam g
<> Siab
Connedted to:
ParametricTower.gh
Break Connection| (% %
Send Changes
2CGaa 0% | o 0000 »|mm 1100 »|£  ozDrafting » Entire Model » | | 03 Architectu...» | [S] 03 Building .. » | C§ Mo Overrides »
Click an Element or Draw a Selection Area. Press and Hold Ctrl+Shift to Toggle Element/Sub-Element Selection. =)

The cross-section of the tower is defined in ARCHICAD

3. Apply a rotation transformation to the array of polygons to create a more complex shape.

Use the rotated collection of polygons as the input parameter for an AC Slab component to

create slabs on each story, which can be adjusted as needed using the transformation
features.
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5. Create division points along the slab outlines: these will constitute 3D curves.

( Synchronize
Curve &> slab D

¢ slab Settings

EEEE Geometry D
Angle

/] 3_ParametricTower - GRAPHISOFT ARCHICAD-64 20 > B e
File Edit View Design Document Options Teamwork Window Help —dx
' YO - A -EEx e’ T I EA|HE2GO -
-l

Do/ am x
Slab (Locked)
~ Design Structure: Generic Slab/Roof|
Top Elevatiorc 19000
[ wa Thickness: 300
Layen: Structural - Bearing
[ boor Loy St
B window Muttiple Elem ents (TAB)
D Column ! !
tﬁ Beam } !
&> slab

Connected to:
ParametricTower.gh

Break Connection (1)
Send Changes

Select in GH yzox
| = 1100 b | &F 02Dmiting » | B Entire Model » | I 03 Architectu...t | [E] 03 Building ... ¥
(=)

DC @@ % |@Q curentzoom b | & 0,00°
Click an Element or Draw a Selection Area. Press and Held Ctrl+ Shift to Toggle Element/Sub-Element Selection.

Slabs of the tower generated in ARCHICAD
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6. Use these curves as input parameters for AC Beam components to model the building’s
twisting frame.

Rotate ( Synchronize
Geometry Geometry )
@ Angle =N
Plane Transform D

Interpolate

Vertices

Synchronize

Curve cﬁ Beam

Flip Matrix
w=

Degree

Periodic

Parameters

i 3_ParametricTower - GRAPHISOFT ARCHICAD-64 20 - O R
File Edit View Design Document Options Teamwork Window Help —ax
oo @ g WO A -EER R TS EN | BERO -

T

[™10. Ground Flear] Jiosan x

7] Marquee

« Design
[ wan Beam (Locked)
Structure: GENERIC - STRUCTURAL
B Door y Top Elevation: 14850
Slank Angle: 55.32°
HH window Width: 300
Layes: Structural - Bearing
U Column ! Stay: 2. Sory !
= gesm i Mukiple Elem ents (TAB) i
&> Slab

Connected to:
ParametricTower.gh

Break Connection| ()
Send Changes

Selectin GH

o & Q|O & ‘Q Current Zoom | r

Click an Elernent or Draw a Selection Area. Press and Hold Ctrl+ Shift to Toggle Element/Sub-Element Selection. [El

The division points along the slab outlines define 3D curves.
AC Beam components attached to these points create the twisted frame in ARCHICAD.

7. Atany time, you can edit the original six-sided polyline in ARCHICAD, thereby modifying the
cross-section of the entire high-rise: the 2D Curve parameter, the basis for the Grasshopper
code, remains associated to its parent element in ARCHICAD.

n 3_ParametricTower - GRAPHISOFT ARCHICAD-64 20 - oIEl ) 3_ParametricTower - GRAPHISOFT ARCHICAD-64 20 -9
File Edit View Design Document Options Teamwork Window Help _ax File Edit View Design D: ions Teamwork Window Help
I PN Hoo 4 O- 8 -EEx|eaT o 1o o & 2 2| H##-~ 2 0- 8 @Ex|eant ™9
— x [JED/An TR I"_‘-uu Jeo/an x |7k
Marquee Building Site {1 Marquee o
- Design ~ Design
[ wan [ wan
[ Boor [l oo
H window B window
[ coumn a D Colum
53 Beam =3 Beam
<> slab &> siab

Connected to: Connected to:
ParametricTower.gh ParametricTower.gh
sreak Connection] (&)

Break Connection| (1))

S
Select in GH

Select in GH

= e

DG A|® & |@Q curentzoom

DER@ 1% e o »|m  1mw »|E  02Datting » ,
Click an Element or Draw a Selection Ares. Press and Hold Ctrl+ Shift to Toggle Element/Sub-Element Selection. )

(=]
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If you edit the original polygon in ARCHICAD, and then press the Send Changes button on the
Grasshopper Connection Palette, the model’s entire geometry is modified accordingly: the 2D
Curve parameter is associative to its parent element.

8. To change the cross-section of a Beam, attach a Beam Settings Node to the Beam
component’s Beam Settings input. From the node’s context menu, click on “Structure of
ARCHICAD Beam”, and select Complex Profile. As a result, the set of input parameters of the
Beam Settings input is modified and now includes the “Profile” parameter on the left side.

Beam Settings

i
=—

Enabled

{ Synchronize Bake...

( Curve &> Slab D Structure of ARCHICAD Beam Rectangular

¢ Slab Settings ' ST T~ Help... 3C  Complex Profile
i . '

Synchronize

Geometry

@ Angle g

Plane Transform [

‘ Curve Qq Beam

Degree a 0 .
ength [ .
( Periodic ( Beam Settings

9. Attach a Profile Input Node to the Profile parameter. Click on the right side of the Input Node
to bring up the Profile Selection palette, which lists all the profiles defined in the ARCHICAD
project. In the upper left of this palette, deselect the Wall and Column elements, so that only
profiles defined for Beams are visible, making it easier to choose the right one.

mt:; RHS Cold Closed
=] (0]
RHS Cold Closed

120x 120
. 0=
i

Precast Beam | 01 Z Beam C Section - Lipped ~

I

C Section - Plain ~ Z Section Column Equal Angles

T B T.

st RHS Cnld Clased T Steel
o
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Parametric Behavior of Generated Elements

Unlike geometry that is embedded using Rhino’s “Bake” command, elements generated in
ARCHICAD remain associated to their generating code. Grasshopper uses an ID-based
method to retain its connection to elements placed in ARCHICAD. If the Grasshopper file is
modified, the ARCHICAD-Grasshopper Connection Tool will update the corresponding
elements in ARCHICAD.

Elements generated by Design or Document Components in ARCHICAD are not just previews:
they are real, editable ARCHICAD elements. When Grasshopper creates these elements, their
status is locked. After you unlock them (Edit > Locking > Unlock), you can open their Settings
dialog in ARCHICAD in the usual way, and modify their parameters. You can also edit the
elements graphically.

a
File | Edit | View Design Document Options Teamwork Window Help

[ ¥ | Undo Lock Selection / Ground Floor Ctrl+Z Q] - 4 g—{ [Z X ‘ :“>~€ A
[} x [:D[SD,-"AII]
- D
|5y Copy Ctrl+C
I—/ % Paste Ctrl+V
e all select Al Ctrl+A
U | ®1 Find & Select... Ctrl+F

5388 search & Replace Text...

BEC

= Grouping 4
% Display Order 3
G| Locking -
‘% Move » T Unlock
% Align ¥ ¥ Unlock All
E'HE_ Distribute 4
® Reshape 3
Element Settings 4
éz Reference Line and Plane 4
3 Mesh

The locked status of elements generated by the Grasshopper code is similar to the “preview”
status in Rhino. Parameters of locked elements can be modified only through the
Grasshopper code. After the elements are unlocked, their parameters can be modified in
ARCHICAD.

By default, a generated AC element’s parameters which are not controlled by the GH code
will have the same settings as the Default Settings of the corresponding tool in ARCHICAD at
the time the element was generated.
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Certain parameters of generated AC elements (those which are used in the node of the
generating component or their Settings nodes) can be edited in Grasshopper, as well as in
ARCHICAD after the elements are unlocked. However, the Grasshopper-based parameter
control takes priority over that in ARCHICAD as long as the GH-AC Connection is active. If a
parameter of an AC component in Grasshopper is assigned a value (e.g. you add a Number
Slider), then that value will be applied every time the Grasshopper code is executed. If you
previously assigned a custom value to that element parameter in ARCHICAD, then that
custom value, too, will be overridden when the Grasshopper code is executed.

If you modify the parameter of a generated element in ARCHICAD using the element’s
Settings dialog box, and if that parameter is not controlled in Grasshopper (either because
the parameter is not available in the generating component or because the parameter has
no assigned value in GH), then your modification remains in effect, even if the Grasshopper
code is executed.

If the GH-AC Connection is not active, then the GH code has no effect on the ARCHICAD
project. You can then freely modify even those elements originally generated by
Grasshopper code. However, once you reactivate the GH-AC Connection, the GH code again
takes precedence in terms of controlling the parameters.

If you use copy-paste to replicate elements in ARCHICAD which were generated from GH
code, then the duplicates will lose their connection to the Grasshopper code. Use this
method to create and compare various designs by trying different values for the Grasshopper
parameters.

Suspended Connection: As long as a dialog box is open in ARCHICAD, awaiting user input, the
connection between Grasshopper and ARCHICAD is suspended. Even if the user changes an
input value in Grasshopper, the change will not take effect until the dialog box in ARCHICAD
is closed. Feedback on the suspended connection is shown in ARCHICAD’s Grasshopper
Palette: the green connection icon stops spinning. In Grasshopper, the nodes with pending
input in ARCHICAD’s direction will turn yellow. A message also pops up to inform the user of
which dialog must be closed before the Grasshopper ARCHICAD Connection is resumed.

File Handling

Elements generated by the Grasshopper code are fully functional, native ARCHICAD
elements that remain in the project even if the GH code is not available. Thus, an ARCHICAD
project that includes elements generated from GH code requires no additional management.
It can be saved as usual to any of the available formats. You can reopen the project without
any problem even if the original Grasshopper code is not available (the elements generated
from GH code will be still be present in the project).

In contrast to ARCHICAD, Grasshopper can have several projects (GH definitions) running
simultaneously in a single instance of the application. However, only one of these files can
communicate with ARCHICAD at a time. To define which of the running Grasshopper files
should be connected to ARCHICAD, use the “Connect Document to ARCHICAD” dialog box,
available from Grasshopper’s File menu.
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Grasshopper - ParametricTower* = B Connect Document to ARCHICAD = B
| 2 Too Doy Seron o et Select the Grasshopper document which should communicate with [
New Document CuteN . ersect  Transform  Display [ ARCHICAD | i
Status Name Fath Connect
& Open Document Q0 == = T
Recent Fies » Definition_2 C:\Users\lbarothy \Deskiop\ATMENETI\Defil Cancel
Definition_1 €\Users'lbarothy'\Desktop\ATMENETI\Defil
(= [E— s 2CQ 30 -
5 save Document As Cirl+Shift+S
Save Backup Cir+Al+S
Connect Document to ARCHICAD.
Eort Quick Image...  Cirl+Shift+Q
< >

¥ Ewort HiRes Image

Document Froperiies..

Create Liser Object O

T Abbon Layout »

& Show in Folder

& specal Folders »
Preferences Ci=ShiftP
Close ParsmetricTower” Gl

The path of the currently active document is shown in bold.
The green icon indicates which definition is currently connected to ARCHICAD.

¢ If you connect an ARCHICAD PLN project to the .GH file which contains the elements’ origin
code, the two files recognize each other, and you can continue your parametric design. For
this reason, it is recommended to save these file pairs to a single folder, and to use related
file names.

e |tis currently not possible to use the ARCHICAD-Grasshopper Connection in a Teamwork
setup (that is, with ARCHICAD and Rhino installed on different computers). An ARCHICAD file
that contains elements generated from GH code can be shared as a Teamwork file, like any
other ARCHICAD project, if the GH-AC Connection is disabled.
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Accessing GDL Parameters of
ARCHICAD Library Parts

By default, Grasshopper cannot access the parameters of ARCHICAD Library Parts. However, you
can modify a Library Part’s GDL code to allow Grasshopper to access the object’s GDL
parameters (see steps below). This is recommended for users familiar with GDL programming.

Note: Geometric Description Language (GDL) is the programming language of ARCHICAD library
parts. These library parts, with file format GSM, can be loaded into your ARCHICAD project through
the Library Manager. When you open a new project with a default template, a standard ARCHICAD
Library is automatically loaded.

To modify an existing Library Part to enable Grasshopper to access its parameters:
1. Goto File > Libraries and Objects > Open Library Part.

2. Select the Library Part that you want to edit.

3. Click View or Open.

| Y

File | Edit View Design Document Options Tesmwork Window Test Help

[ Mew v Bl - 0O~ - |85¢(mz
E"; Open >

[ Close Project  Ctrl+Shift+W

x [ 1armchair 01 21]

Save Ctrl+S
Bl saveas. Ctrl+Shift+S

@] Publish BIMx Hyper-modl...

il 2 -
T ' u Open Library Part
External Content » Open Library Part from: B3] ARCHICAD Library 21 v
| Libraries and Objects ¥ I Library Manager... _
EEO
Info » Manage BiMcloud / BIM Server Libraries... _
= . (] ARCHICAD Library 21 A ’ A
: 5
Plot Setup... [ Create Container... Bl i ik around TrogesSH
BT Plot... B Bxtract a Container.. B [Himg] HOR Images 21 .
Page Setup Ctrle ShifteP a B ARCHICAD Library 21.1cf Amchair 01 Amchair 02
== 21.gsm 21.gsm
& print... Ctrl+p New Object... + B3 ovject ibrary 21 ;
5 = 3 4 B 1. BASIC LIBRARY 21 g
— Cueq | [B Qpen Object.. Ctrl+Shift-0 [ S 4
i v 2 B9 1.1 Furnishing 21 p—
== |1l Save Selection as... » & i’
55 Applmnces 21 Armchair 03 Armchair 04
B3 Bathroom Accessories 21 21.gsm 21.gsm
@ B2, Import Blocks from DXF/DWG B Beas 21 —_
i
Hﬁ B cabinets and shelves 21 T
8 B3 chairs 21 —
Bl Couches and Sofas 21 v BarStool 21.gsm Bean Bag 21.gsm
= < > v
Docur
+—t
pers

4. The GDL Editor is opened in a new tab, where you can edit the object’s GDL code.
5. Click on the Parameters button (at left) to open the object’s parameter list.

6. Click New (at top left) to add a new parameter to the list.
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7. Set up this new parameter as follows:

Display: activate the red cross pushbutton to make the variable invisible on the user
interface.

Variable: type "ParamcontrolByGrasshopper"
Type: Boolean

Name: enter any name

Value: ON
[ W SurveyPoint - GRAPHISOFT ARCHIC
File Edit View Design Document Options Teamwork Window Test Help
10 o T - @ B x| EXIYX
|
S50. Ground Floor] [/ Armehair 03 21] % [[)D /AN
= New Delete Q [
o Display Variable Type MName Value
2 [EI?I B I U |ParamcontrolByGrasshopper I Er IEnabIe Grasshopper to co_-=
] + A 5! Dimension 1 580
EE B B Ot Dimension 2 680
- s iyt =] Height 300
= E gs_detlevel_3D_m a8 3D Detail Level Detailed
Details B gs_seat_height =] Seat Height 350
= gs_2D_representation = 2D Representation
Migration 5 = gs_detlevel 2D Abc 2D Detail Level Scale Sensitive
Components s+ XS gs_detlevel_2D_m EH 2D Detail Level 0
Descriptors
Seripts : XS as_SymbolType_Mask a8 Symbol Type Enable Mask 4083
Master D H = gs_cont_pen U Contour Pen 4
2D /o= = gs_fill_type %, Fill Type 65
3D D 5 =3 gs_fill_pen U Fill Pen 19
Properties [ N = gs_back_pen U Fill Background Pen 19
Parameter = = gs_min_space = Minimal Space
Interface ™ * = MSFront &3 Minimal Space in Front 30
Trera e | % = MsSide e Minimal Space on Sides 150
Backward Migration || H = MSRear E_E Minimal Space Behind 300
H gs_3D_representation = 3D Representation
2D Symbol 3 s = gs_resol a8 Resolution 18
Preview Picture i = gs_shadow 5] Shadow On
2D View [ = gs_full_edit B Extra Hotspot Editing On
3D View = #X AC_show2DHotspotsin3D = Shaw 2D Hotspots in 30 Off O

8. After the new parameter is set, use File > Save as to save the Library Part under a new name
to the Embedded Library.

The newly modified, duplicate element is now available in Grasshopper.
9. In Grasshopper, place an Object Settings Node on the canvas.
10. From the context menu, choose Select ARCHICAD Library Part.

11. From the appearing dialog, browse for the new element. Since Grasshopper detects the
ParamcontrolByGrasshopper parameter, the object’s GDL parameters are selectable on the
right. Every parameter that you check here will (after you click Select in the dialog box)
appear as an input parameter on the left side of the Object Settings Node. From this point on,
you can define these GDL parameters, too, in Grasshopper.
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Select ARCHICAD Library Part B
Search Object | search Parameter: |
Embedded Library Name Type  Variable Name
Linked Libraries
{Z) Bllcoud / BIM Server Libraries General

Dimension 1 =2
Dimension 2 ¥ B
Height F=2 a7
Surace B suffaint

B9 Buitin Libraries

T

Enabled

@ Bake..
I
o

Select ARCHICAD Library Part I—)

Help... Test Object gsm

&\, Warning: Setiing mutiple Library Pant par i istencies i
ARCHICAD slement. For more information, open the Grasshopper- ARCHICAD Live Connection User Guide from ARCHICAD's Help menu

o

Note: Be careful when managing GDL objects via Grasshopper. Library part parameters are often
interdependent, and modifying one value will modify other values too. Grasshopper does not detect
this interdependence. If you adjust several values in Grasshopper simultaneously which are
interdependent, an error may occur if both Grasshopper and the GDL Parameter script seek to modify
the interdependent values simultaneously.

If contradictory information is given as parameter inputs for Library Elements in Grasshopper, then
objects may be placed differently than expected. The most common phenomenon that is that Objects
are not updated when a parameter is changed in Grasshopper. In case of Doors/Windows, the
settings dialog can misbehave when you try to edit the elements manually.

0 Xk Untted- GRAPHSORT ARCHICAD-8120

Fie £t View Deign Document Optons Tesmwork Window Help

ISR Pl SN [SREER [ SFTEN o|R2LG[®

FEHS] *

[0 Ground Floon Ososan [y p— x C3iSoutn Hetiont

300 90 0 T m

synchronize (Il
wai (i
. . g window
¢ Horzonal pisance [E3
¢ Window Settings

Window Settings

inconsistent parameter setup B s

-
® oem
@ aunse

Recommendation: Do not use Grasshopper to modify multiple GDL parameters simultaneously if their
values are interdependent.
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